January 2026 Forecast Checklist & Guidelines:
Unit Checklist for January 2026 Forecast
· Have you submitted a forecast within your approved budget allocation – i.e., No planned carryforward spend? If not, please identify the value of pre-approved amounts.
· Have you identified your plan for the self-funded inflation contribution (if relevant) in your forecast template if not already resolved prior to forecasting?
· Have you identified your plan for the Deficit Contribution target (if relevant) in your forecast template if not already resolved prior to forecasting?
· Have you completed the Summary of Financial Position at the BPU level to explain key variances and does this reconcile to your reported financial position?
· Have you identified material personnel changes in the personnel tab and do these tie to your forecast?
· Have you explained Base and OTO budget adjustments that change your net budget position, in the ‘Jan Forecast’ tab notes?
· If the above Base and or OTO budget adjustments are from central have you included them in the new ‘central budget adjustment’ columns?
New for the January 2026 forecast:
Summary
For the 25/26 forecasts we have reformatted the Summary of Financial Position on the ‘summary’ tab. This view should be familiar to most as it is similar to the summary used in the 25/26 College and Shared Service (Unit) budget plans. This new format labels each category as an inflow (including central contribution) or an outflow and highlights specific object or object types most relevant to unit budget planning and forecasting. This summary is where units are asked to explain their summary of financial position, material variances and plans to achieve deficit contribution and or compensation inflation targets – see reminders section below and Appendix D for further details.
Personnel Plan
For 25/26 forecasting we are asking that units provide details on material personnel changes that are not reflected in FRS at November 30th. This format is similar to what was used in the 25/26 unit budget plans. These plans will allow the budget team to better understand the position changes and assumptions that have been incorporated into unit level forecasts and allow for more informed decision making when assessing resources. This is required to be completed at the BPU level as indicated in the Budget Liaison Contact List. Please see Appendix E for further details.
Deficit Contribution (66013) - Colleges Only
For 25/26 colleges were given deficit contribution targets that have been recorded in object 66013. Colleges are required, if able to articulate and not already implemented, their plan to address this through budget adjustments for their balance in 66013 in the appropriate FRS object codes on the ‘Jan Forecast’ tab. Please  include a note(s) indicating this budget adjustment(s) on the ‘Jan Forecast’ tab. If you are not able to articulate how you will accomplish meeting your target and therefore there is a remaining balance in 66013 on the ‘Summary’ tab, please briefly identify your plan to address your remaining target, which should include FRS category where possible and timeline for implementation. See Appendix D for further details.
Self-funded Compensation Contribution (66012)
For 25/26, units were given self-funded inflation contributions that have been recorded in object 66012. Units are required, if able to articulate and not already implemented, their plan to address this through budget adjustments for their balance in 66012 in the appropriate FRS object codes on the ‘Jan Forecast’ tab. Please  include a note(s) indicating this budget adjustment(s) on the ‘Jan Forecast’ tab.
In 25/26 Shared Services have access to up to 50% of their compensation inflation target available in OTO budget and this has been allocated to units by VPs. For eligible BPU’s that require all or a portion of this available budget, please include this transfer in your OTO budget adjustment column in object 66012 on the ‘Jan Forecast’ tab. 
If you cannot articulate how you will accomplish meeting your target and therefore there is a remaining balance in 66012 on the ‘Summary’ tab, please briefly identify your plan to address your remaining target, which should include FRS category where possible and timeline for implementation. If you require all or a portion of the 50% compensation target coverage to balance (service units only), please include a note indicating this budget adjustment on the ‘Jan Forecast’ tab in alignment with VP direction. See appendix B and Appendix D for further details.
Budget and Actual Data Loads
For 25/26 forecasts, the Budget Team will load all forecast template data for each unit based on July 31, 2025 (January) and November 30, 2025 (January) data. Units will no longer be required to download data from FRS into their individual templates. If your unit will be combining files, the budget team will populate a combine file with data at the BPU level to ensure accurate data population of the ‘Summary’ tab.
Vacancy Savings Plans (not required)
For 25/26 forecasting, detailed vacancy savings plans required in historical forecasting years are no longer required. Rather vacancy savings may be presented, if relevant, consolidated in your personal plan. See Appendix E for further details.
Enrollment and RSA Modelling
For 25/26, IRP will provide an enrollment and revenue sharing tool to support colleges in forecasting academic program revenues. The tool will estimate academic transfer revenues based on enrollment data and college input. Undergraduate Program, Undergraduate Course, Course-based Masters and Thesis-based graduate program enrollment and revenues will be supported by the tool.

Central Budget Adjustments
For 25/26 budget adjustments that have been approved to be centrally funded but are not yet allocated in FRS budget data, please report these adjustments in the new Base and OTO central adjustment columns, column J and L respectively. These columns should only be used for approved central budget that is being provided or central budget that is being returned, ALL other budget adjustments should be done in the standard Base and OTO budget adjustment columns, columns F and H respectively.
Reminders for the January 2026 forecast:
Summary of Financial Position
As part of the 2025 January forecast, we are asking units again to complete a brief Summary of Financial Position explanation included on the ‘Summary’ tab. This will be a high-level explanation of your forecasted in-year position by identifying key variances. This is required to be completed at the BPU level as indicated in the Budget Liaison Contact List. See Appendix D for further details.
Variance Explanations
Consistent with 24/25 forecasts, units are not required to provide detailed variance analysis on the ‘forecast’ tab unless reporting material variances. Units may choose to continue to provide variance explanations using the forecast to support their internal planning and continuity. See Appendix B for further details.
Unit 25/26 Planning Parameters
· Carryforward spending is not approved, except in special previously approved circumstances
· Self –funded compensation contributions and deficit contributions (colleges) should be resolved in-year and at the earliest possible opportunity. If your unit has a balance in 66012 or 66013 please identify your plan to address this within your forecast. 
· These planning parameters are also included for completeness in Appendix B.
Please review your unit forecast submission to ensure the information is correctly consolidated, calculated and the automatically populated columns reconcile to FRS data with any additional adjustments clearly noted. The budget team has created a unit checklist that should be reviewed prior to submissions.
Please use the following guidelines (Appendix A-E) to prepare a unit forecast of year end results for the 2025/2026 fiscal year.
Appendix A: Forecast Reporting Guidelines
Appendix B: Instructions for Forecast Templates
Appendix C: Combine Template Forecast Instructions
Appendix D: Summary of Financial Position
Appendix E: Personnel Plan

Please prepare a 25/26 January Forecast for each of your areas of responsibility separately by fund for the General Operating funds (100 - General Operating; 102 - OVC Special Grant; 104 - Diploma Education; 105 – OVC HSC). Please refer to the Budget Liaison Contact List for details on the budget units to report on by fund. The Dean’s Office or Directorate Office is responsible for accumulating, consolidating, reviewing, and approving the detailed forecasts for their respective college or directorate, as outlined in the contact list.
[bookmark: _Hlk110848153]The Budget Team compiles all the college and shared service forecasts and budget plan information into the University summary and is presented to the Board of Governors. To be able to do this accurately, we need consistent submissions from all units.  Please ensure that your forecast is in the template provided.
PLEASE E-MAIL YOUR JANUARY 2025 FORECAST TEMPLATE SUBMISSION, INCLUDING YOUR COMPLETED, FORECAST, PERSONNEL INFORMATION AND SUMMARY OF FINANCIAL POSITION TO:
	Budget.innovation@uoguelph.ca


 SUBMISSION DEADLINE FORECAST: January 13, 2025
January 2026 Forecast Preparation Support:
For assistance in preparing your forecast, please contact your Decision Support Consultant, as outlined on the Budget Liaison Contact List for each budget unit.

[bookmark: AppA]Appendix A: Forecast Reporting Guidelines
A.  Purpose of Forecast:
There are two in-year forecasts that need to be completed for each budget unit in this fiscal year.
The forecast due on January 13, 2025 estimates units’ total spending for the 2025/2026 fiscal year, based on one semester of actual results. The January forecast is to update the above in-year forecast based on an additional semester of actual results. Both forecasts will be presented to the Board of Governors. 
The fundamentals for building your forecast and explaining variances between actual and budgeted results should be part of your normal financial management routines. This guideline provides general instructions for preparing a forecast in a consistent format for summary purposes. Explanations of key cost and revenue assumptions are an integral part of every forecast submission.
The Budget Team compiles all the college/divisional forecasts into the University summary which is presented to the Board of Governors.
B.  Assumptions:
Each unit will have different methods and capabilities of completing this forecast.  Some have ongoing forecasting procedures; others have periodic forecasting efforts depending upon both the time of year and status of their budget.  This requirement to complete a forecast should be an extension of those procedures and not in addition to or separate from them.  Methods of forecasting expenditures and revenues may include using historical trends, using current commitments for personnel costs, and using planned expenditures not yet recorded in FRS.  The segregation of special purpose or special project funds from the rest of operating funds may be helpful in compiling this information.  Please include notes on the ‘Jan Forecast’ tab to outline your assumptions, variances (at your discretion), or any other relevant information.
C.  Degree of Accuracy:
We want to encourage units to be forecasting as accurately as possible given that this information will be used to help advise University leadership on managing financial pressures. The acceptable target for accuracy is 2% of your overall budget (excluding carryforward) in 2025/26.  
By its nature, any forecast contains a certain element of estimation and intelligent guesswork.  This exercise is no exception. You will not be able to forecast exactly. However, your information is the basis of the consolidated University forecast, and accuracy is important. Please ensure you list any assumptions associated with major revenue and expense forecasts for the year.


[bookmark: AppB]Appendix B: Instructions for Forecast Template
The following appendix provides instructions on how to complete your January forecast, and an explanation of the columns requiring input within the “Jan Forecast” tab. 
A. Instructions on Completing Forecast Template (yellow highlighted columns)
Step 1: Within the “Jan Forecast” tab, using columns titled “Base Adjustment” and “One-time Adjustment” add in your units Base and/or One-time budget adjustments as expected/ approved. These adjustments are to be used if the unit has a budget adjustment that is expected but has not yet been recorded in FRS at the time of the budget data download (utilized if necessary).
Step 2: Within the “Jan Forecast” tab, using the column titled “Additional Spend” add in any additional spend forecasted to year end. This is the column you are requested to input estimated expenses and revenues (up to April 30, 2025) which have not yet been recorded in FRS for 2025/2026. If your department has any commitment or actuals adjustments, please reflect these adjustments in this column as well.  
Please note that when filling out your forecast in these fields you can either fill out at the object level or at the type level (grouping level 2), not both. The exception to this is in salaries as each object code in salaries needs to be forecasted at the object level to get the appropriate benefit rate. If you have values in both the object and the type level the summation formula at the type level will, by default, sum the object codes. For example, the below Figure 1A has a total of 7 in Column P at the type level (grouping level 2 total on Memberships and Training) and is pulling based on information provided at the object level and ignores the amount provided on the total for Memberships and Training. In Figure 1B, if you place data at the type level total and nothing at the object level the formula will pull in the total of $200 as the Memberships and Training total.
Figure 1A
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Figure 1B
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For any unit using formulas to bring in information from another spreadsheet, simply drag down your formula in any fillable yellow coloured column. Please note: the benefits will only calculate in the output columns not the input columns due to the drag and drop functionality. If you are pulling from an external file, please copy and paste values, so when reviewing the template there are no reference errors.  The three column headers in Yellow, Base Adjustment, One-time adjustment, and Additional spend are the columns in the main portion of the template that units are requested to provide input as laid out in steps 1-2 above. 
Step 3: Within the “Jan Forecast” tab,The column titled ‘Notes’ is where information should be included describing assumptions made and explaining budget adjustments related to self-funded compensation contribution (66012) and Deficit Contribution (66013) solutions in 25/26 or budget adjustments that change a unit’s net budget position.  Units are not required to complete this notes field for variance explanations (which will be completed in the Summary of Financial Position) but may choose to do so to support their internal planning and continuity. Units should also be prepared to speak about their unit activities and plans in greater detail and so may benefit from a more detailed variance analysis at this level. 
General Forecast Instructions
Below are some general instructions for the 2025/2026 forecast procedure:
1. As mentioned in the Overview you will need to create a separate forecast report for each sub-fund in General Operating (fund #100,102,104,105) as part of your January 2025 Forecast submission you create for each sub-fund in General Operating. 
2. Units are welcome to complete a Forecast at lower hierarchical levels then indicated in the Budget Liaison Contact List however you must submit a summary submission for the budget unit you are reporting on, as outlined in the Contact Listing. Please see Appendix C for help with combining files.
3. Auto Benefit Calculations: In this template, benefits will automatically be calculated and populated in the appropriate object code line (62306).
Self-funded Compensation Contribution (66012)
For 25/26 units were given self-funded inflation contributions that have been recorded in object 66012. Units are required to identify their plan, through budget adjustments, by FRS category (where possible) in the Jan Forecast tab. If a balance remains in 66012 you are asked to explain this in your summary of financial position explanation on the Summary tab. 
Deficit Contribution (66013)
For 25/26 colleges were given deficit contribution targets that have been recorded in object 66013. Units are required to identify their plan, through budget adjustments, by FRS category (where possible) in the Jan Forecast tab. If a balance remains in 66013 you are asked to explain this in your summary of financial position explanation on the Summary tab.
Unit Planning Parameters for 2025/26
· Carryforward spending is not approved, except in special previously approved circumstances.
· Self –funded compensation contributions and deficit contributions (colleges) should be resolved in-year and at the earliest possible opportunity. If your unit has a balance in 66012 or 66013 please identify your plan to address this within your forecast. 
[bookmark: _Unit_Checklist_for]Completed forecasts are to be submitted to the Budget Office by Tuesday, January 13, 2025 to budget.innovation@uoguelph.ca 


[bookmark: AppC][bookmark: AppD]Appendix C: Combine Template Forecast Instructions
The “Forecast Template Combine” file allows users to combine multiple unit forecast templates into one combined template 

This will be done using a built in Excel function called Power Query 

Steps:
1. Close any templates that are open 

2. Data -> Get Data -> From File -> From Folder

[image: ]
3. In the popup, open the folder where the templates are located and click open
Note: Folder must contain nothing other than the files to be combined

[image: ]

4. Click drop down button for Combine and select “Combine & Load”
Note: Make sure all templates to be combined are displayed on the popup 
[image: Graphical user interface, text, table

Description automatically generated]
5. Select Jan Forecast under Parameter and click ok

[image: A screenshot of a computer

AI-generated content may be incorrect.]

6. In the new sheet that is created, close "Queries & Connection" on the right side

[image: Graphical user interface, application

Description automatically generated]

7. In the Forecast sheet, enter the name of the sheet that was created into cell C6 (highlighted in yellow), this tells the Forecast sheet where to pull the data from

[image: A picture containing table

Description automatically generated]
8. Check to see if data is pulled correctly 

Notes:
1. Refreshing Data
If you make any changes to any of the templates that has been compiled, you can simply refresh the data by Data -> Refresh All
Note: Must have all templates closed
[image: ]
2. Comments
Comments will not be combined. Units can add comments in Column S as necessary. 



[bookmark: AppE][bookmark: AppF]										
Appendix D: Summary of Financial Position 
Units are asked to comment on their summary of financial position included in the ‘Summary’ tab of the Forecast

This summary is prepared utilizing information from the January Forecast tab. Units are asked to provide a summary of their unit’s in-year financial position to help explain forecasted changes.

If your anticipated year-end position is greater than $100,000 or 2% of your overall budget (excluding carryforward), please provide a brief, high level explanation of your forecasted in-year position by identifying major variances. Please indicate this in the box provided on the ‘Summary’ tab.
 
e.g. - Through efforts to increase revenue and reduce cost, dept x expects a year-end surplus of $400K due to: RFT personnel savings of approximately $800K, textbook sales growth of $200K, and extraordinary equipment expenditures of $600K to replace end of life machinery.
 
Column variance analysis/explanations:
 
If there are material variances across categories that have not been explained in your Summary of Financial Position explanation, please include details in ‘comments’ column to explain these variances. Explanations should reconcile to your forecasted position.
 
Compensation Contribution 66012 balance:
 
If you are able, please articulate your plan to address your units balance in 66012 in the appropriate FRS object codes on the 'Jan Forecast' tab using the budget adjustment column. Your budget  in the Summary table , therefore, should include adjustments to offset object 66012. If you cannot articulate this and therefore there is a remaining balance in 66012 in the summary table, please briefly identify your plan to address this. This should including FRS category where possible and timeline for implementation. Please include this in the box provided to explain your summary of financial position. 
Deficit Contribution 66013 balance:

If you are able, please articulate your plan to address your units balance in 66013 in the appropriate FRS object codes on the 'Jan Forecast' tab using the budget adjustment column. Your budget in the Summary table , therefore, should include adjustments to offset object 66013. If you cannot articulate this and therefore there is a remaining balance in 66012 in the summary table, please briefly identify your plan to address this. This should including FRS category where possible and timeline for implementation. Please include this in the box provided to explain your summary of financial position. 
[bookmark: _Appendix_E:_Personnel]Appendix E: Personnel Information 
For 25/26 forecasting we are asking that units provide details on material personnel changes included in your forecast in a similar format to what was used in the 25/26 unit budget plans. These personnel plans will allow the budget team to better understand the position changes and assumptions that have been incorporated into unit level forecasts and allow for more informed decision making when assessing resources. 
Please use the table included in the Personnel Plan tab of your forecast to capture material plans not currently reflected in FRS. Examples may include new hires , vacancy savings, lumpsum payments, position collapses etc. Forecast and budget adjustments should be materially explained in this personnel plan.
A detailed vacancy savings plan is not required, but rather you may present consolidated vacancy savings assumptions in this personnel plan. For more fulsome planning, non-personnel objects that are frequently used in personnel planning have been included in the table dropdowns for example, fellowships, work study recoveries, donations etc. Please use rows 51-59 if required to add additional objects.
This personnel plan is required to be completed at the BPU level as indicated in the Budget Liaison Contact List. 
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formula will pull in the total of $200 as the Memberships and Training total.
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